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1 About this manual
This manual guides you through the IBM® Rational® Directory Server (RDS) 
installation and uninstallation. It contains the following sections:

• Introduction

• Types of RDS installations

• Preparing installation information

• Server Installation

• Server Removal

• Client Installation

• Client Removal

• Troubleshooting RDS

RDS documentation
This section provides the information on the related documents available for 
RDS. The following RDS documents are available on the Product Support Web 
site, http://www.ibm.com/software/rational/support/

Document name Description

IBM Rational Directory Server 
Installation Guide

Provides information about how installing 
RDS.

IBM Rational Server Product 
Manual

Provides detailed information about RDS 
features supported in this release.

IBM Rational Server 
Administration Manual

Provides information about RDS 
administration.
IBM Rational Directory Server Installation Guide 1
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Chapter 1:  About this manual
Contacting IBM Rational Software Support
If the self-help resources have not provided a resolution to your problem, you 
can contact IBM® Rational® Software Support for assistance in resolving 
product issues.

Note  If you are a heritage Telelogic customer, a single reference site 
for all support resources is located at http://www.ibm.com/
software/rational/support/telelogic/

Prerequisites
To submit your problem to IBM Rational Software Support, you must have an 
active Passport Advantage® software maintenance agreement. Passport 
Advantage is the IBM comprehensive software licensing and software 
maintenance (product upgrades and technical support) offering. You can enroll 
online in Passport Advantage from http://www.ibm.com/software/lotus/
passportadvantage/howtoenroll.html

• To learn more about Passport Advantage, visit the Passport Advantage FAQs 
at http://www.ibm.com/software/lotus/passportadvantage/
brochures_faqs_quickguides.html.

• For further assistance, contact your IBM representative.

To submit your problem online (from the IBM Web site) to IBM Rational 
Software Support, you must additionally:

• Be a registered user on the IBM Rational Software Support Web site. For 
details about registering, go to http://www.ibm.com/software/support/.

• Be listed as an authorized caller in the service request tool.

Submitting problems
To submit your problem to IBM Rational Software Support:

1. Determine the business impact of your problem. When you report a 
problem to IBM, you are asked to supply a severity level. Therefore, you 
need to understand and assess the business impact of the problem that you 
are reporting.
2 IBM Rational Directory Server Installation Guide
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Submitting problems
Use the following table to determine the severity level.

2. Describe your problem and gather background information, When 
describing a problem to IBM, be as specific as possible. Include all relevant 
background information so that IBM Rational Software Support specialists 
can help you solve the problem efficiently. To save time, know the answers 
to these questions:

• What software versions were you running when the problem occurred?

To determine the exact product name and version, use the option 
applicable to you: 
• Start the IBM Installation Manager and select File > View Installed 

Packages. Expand a package group and select a package to see the 
package name and version number. 

• Start your product, and click Help > About to see the offering name and 
version number. 

• What is your operating system and version number (including any 
service packs or patches)? 

• Do you have logs, traces, and messages that are related to the problem 
symptoms? 

• Can you recreate the problem? If so, what steps do you perform to 
recreate the problem? 

Severity Description

1
The problem has a critical business impact: You are unable to 
use the program, resulting in a critical impact on operations. 
This condition requires an immediate solution.

2 This problem has a significant business impact: The program 
is usable, but it is severely limited.

3
The problem has some business impact: The program is 
usable, but less significant features (not critical to 
operations) are unavailable.

 4
The problem has minimal business impact: The problem 
causes little impact on operations or a reasonable 
circumvention to the problem was implemented.
IBM Rational Directory Server Installation Guide  3



Chapter 1:  About this manual
• Did you make any changes to the system? For example, did you make 
changes to the hardware, operating system, networking software, or 
other system components? 

• Are you currently using a workaround for the problem? If so, be 
prepared to describe the workaround when you report the problem.

3. Submit your problem to IBM Rational Software Support. You can submit 
your problem to IBM Rational Software Support in the following ways:

• Online: Go to the IBM Rational Software Support Web site at https://
www.ibm.com/software/rational/support/ and in the Rational support 
task navigator, click Open Service Request. Select the electronic 
problem reporting tool, and open a Problem Management Record 
(PMR), describing the problem accurately in your own words.

For more information about opening a service request, go to http://
www.ibm.com/software/support/help.html

You can also open an online service request using the IBM Support 
Assistant. For more information, go to http://www.ibm.com/software/
support/isa/faq.html.

• By phone: For the phone number to call in your country or region, go 
to the IBM directory of worldwide contacts at http://www.ibm.com/
planetwide/ and click the name of your country or geographic region. 

• Through your IBM Representative: If you cannot access IBM 
Rational Software Support online or by phone, contact your IBM 
Representative. If necessary, your IBM Representative can open a service 
request for you. You can find complete contact information for each 
country at http://www.ibm.com/planetwide/. 
4 IBM Rational Directory Server Installation Guide
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Conventions used in this guide
Conventions used in this guide

Typeface Description

Italic Used for book titles and terminology.

Bold Used for items that you can select and menu 
paths, also used for emphasis.

Courier Used for commands, file names, and directory 
paths. Represents command syntax to be 
entered verbatim. Signifies computer output 
that displays on-screen.

Courier Italic Represents values in a command string that 
you supply. For example, 
(drive:\username\commands).
IBM Rational Directory Server Installation Guide  5
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2 Introduction
RDS is a single enterprise directory solution designed for user authentication and
administration for IBM® Rational® Solutions for Enterprise Lifecycle
Management tools. RDS allows the users to log on using the same credentials
across Enterprise Lifecycle Management tools for which they have authorized
access.

RDS is designed to support a wide range of platforms. For more information on
the platform support see Operating system requirements (page 13). 
The RDS comes with the Graphical User Interface (GUI) based client application 
IBM® Rational® Directory Administration (RDA), that can be installed 
separately. For information on installation instruction and procedure, refer to 
Installing the RDA (page 31).

Note  The RDS 5.1.0.2 should be installed on an existing RDS 5.1 
server. The RDS 5.1.0.2 automatically updates both server and 
client. You can also install the client separately by installing the 
RDA.

Obtaining the RDS software
You can download the RDS from the support site or from the zip distribution. 
After downloading the RDS, make sure you verify the MD5 checksum available 
under the support site, http://www.ibm.com/support/fixcentral/ matches the 
downloaded installer. This will ensure that the downloaded installer is not 
corrupted.

Installation sequence
The RDS must be present in the system for the other tools to connect. You can 
install the RDS prior to or post other tools installation.

Remote installation of RDS
RDS requires graphical X environment for installation. In case of remote 
installation by X environment, ensure that DISPLAY environment variable 
should be set appropriately as, $ export DISPLAY=localhost:0. For more 
information, see the platform specific manual for details.
IBM Rational Directory Server Installation Guide 7
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Chapter 2: Introduction
Types of RDS installations
There are two types of RDS installations:

Preparing installation information
Preparing installation information in advance can help you to complete the
installation process quickly. Before starting the installation, consider creating a
worksheet to record the basic installation information, as described for a typical
installation in the following table..

Installation type Description

Server Installation Installs RDS 5.1.0.2 fix pack on an existing
RDS 5.1 server. The RDS provides user
authentication and administration across
Enterprise Lifecycle Management tools using
the same credentials. The server installation
also provides the option to install Web RDA
client. However, you can choose to install that
separately.

Client Installation Installs the client (RDA) on a local machine.
The client can access the server on the local
machine or on a network.

Description Example

Host name Same as your existing RDS 5.1 server.

Directory server port number Default LDAP port. Use the same port number 
given at the time of RDS 5.1 installation.

Secure port number (Default LDAP SSL port. Use the same secure 
port number given at the time of RDS 5.1 
installation. 

Directory administrator password This must be the tdsadmin password given at 
the time of tdsadmin user creation.
8 IBM Rational Directory Server Installation Guide



Frequently Asked Questions
Frequently Asked Questions
1. Which are the external LDAP servers supported by RDS?

Sun Java(tm) System Directory Server and Microsoft(r) Active Directory 
Server.

2. What is the schema required by RDS in the external corporate server?

The user information are extracted from the corporate servers based on the 
person/inetOrgPerson schema class and the primary attributes cn, 
sn, email, uid, givenname, telephoneNumber, mail, 
facsimileTelephoneNumber, description, postalAddress, 
and sAMAccountName.

The group information are extracted based on the group/
groupOfUniqueNames schema class and the attributes member/
uniqueMember, description.

3. Do we need an Administrator privileges to create a partition?

You need a corporate LDAP server user with a Read access to the search 
bases specified in the partition. 

4. I cannot use RDA on Solaris to create a partition with SSL enabled?

This is a known limitation. You need to install RDA on Windows as a 
workaround.

Directory administrator ID tdsadmin (set by default)

Installation directory Same as your existing RDS 5.1 server. 
For example:

• /var/IBM/Rational/RDS_5.1 
or any other specified path.

• Tivoli directory server binary is 
always installed under /opt/IBM/
ldap/V6.2

Description Example
IBM Rational Directory Server Installation Guide  9



Chapter 2: Introduction
5. Why DOORS do not show up a user after changing the name of the user from one ou to 
another in the corporate LDAP?

If the name of a user (firstname, lastname, cn etc.) is changed keeping the 
same UID, or if a user is moved from one OU to another in the corporate 
LDAP, DOORS may not show up the user. The reason is, the RDS has 
already created an extended user object with the uid as the user logon name 
(based on the logon attribute selected in the corporate partition) and 
tdsCorporateDn as the corporate DN of the user. If the corporate DN of 
the user changes in the corporate LDAP server, RDS will try to recreate the 
extended user object with the same user logon name (which is not changed 
in corporate LDAP) and would fail, as the user object with the same logon 
name already exists in the corporate LDAP. Hence, the particular user would 
not be shown in DOORS.

To solve this issue, it is recommended to modify the required attributes of
the extended user object in RDS. Deleting the extended user object also
solves the issue but it may delete the DOORS specific values for that user
object, which may lead to information loss.

6. Will error opening *.cat files messages affect functionality of RDS 5.1 for Tivoli in 
anyway?

No. You can ignore such error messages, they keep coming because of a 
minor localization issue with Tivoli which will no way affect RDS and its 
functionalities.

7. Is RDS supported on VMWare?

Currently, the RDS is not supported on a virtual environment.

8. How do you change the Webserver port from 8080 to any other values for IBM Rational 
Directory Administration (RDA)?

To change the default port number:

a. Edit the following lines in the Server.xml file located under 
<RDS_HOME/RDA_HOME>\WebAccessServer\apache-tomcat-
6.0.16 (-6.0.24 for 5.1.0.1 and 5.1.0.2)\conf folder:
Connector port="8090" protocol="HTTP/1.1" 

connectionTimeout="20000" 

redirectPort="8443" />

<!-- A "Connector" using the shared thread pool-->
10 IBM Rational Directory Server Installation Guide
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b. Restart the RDA for the changes to take effect.

Note  The new port number is changed to 8090 in the above 
example.
IBM Rational Directory Server Installation Guide  11
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3 Server Installation
This chapter contains the installation instructions for installing RDS on Solaris, 
and Linux platforms. 
This chapter contains the following sections:

• System requirements

• Before installing RDS

• Installing the RDS

• Post installation instructions

System requirements
The following section describes the system requirements for the RDS.

Industry standards

The RDS is developed based on the following industry standards.

• LDAP v3 operations

• LDAP search filters

• LDAP v3 intelligent referral

Operating system requirements
RDS and RDA are supported on the following platforms:

• Sun Solaris 10 operating system 64 bit ( / SPARC Platform)

• Red Hat Enterprise Linux Server 5 operating system 32 and 64 bit
IBM Rational Directory Server Installation Guide 13



Chapter 3: Server Installation
The following table details the list of additional software that must be available in 
the system. 

Note  For more information on operating system requirements see, 
http://publib.boulder.ibm.com/infocenter/tivihelp/v2r1/
topic/com.ibm.IBMDS.doc/sysreq10.htm#sysreq

Operating system Supported OS versions Additional required software

Solaris operating system Solaris 10 operating system for SPARC® • The Korn shell is required.
• pkgadd system utility should exist.
• 64- bit kernel.
• If raw devices are used, patch 125100-07.

Red Hat Linux Red Hat Enterprise Server 5 for x86 (32 
and 64 bit OS)

The following packages needs to be installed before 
installing the Rational Directory Server:

1. glibc-devel 
2. glibc-headers 
3. libaio
4. compat-libstdc++

some of the rpm names of these packages are:

• glibc-2.5-18.i686.rpm 
• glibc-common-2.5-18.i686.rpm 
• glibc-common-devel-2.5-18.i686.rpm
• glibc-headers-2.5-18.i686.rpm
• nscd-2.5-18.i686.rpm 

The rpm name could end with "i386" based on the 
hardware details (/ confirm with command "uname -m"). 

Libraries libstdc++so.5 and libaio.so.1 should exist.

You might need to upgrade to the latest patch level of 
these packages. For more information on the patches, see 
the Red Hat support site at http://rhn.redhat.com.
14 IBM Rational Directory Server Installation Guide
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Before installing RDS
Disk space and memory requirements
Requirement for RDA
Make sure that sufficient disk space is available before installing the RDA. The
following table shows the minimum disk space and memory requirements for
RDA.

Before installing RDS
Before you install the RDS, ensure that the system is equipped with the set of 
configurations recommended in this manual to avoid any installation errors. You 
need atleast 5 GB of free disk space and at least 1.5 GB free space in /tmp 
folder. 
This section also describes the following settings that must be in place.

• RDS 5.1 server

• Shell requirements

• Root settings

• Libraries and utilities

• What is not supported

RDS 5.1 server

Make sure that RDS 5.1 is present and running in your system before installing 
the RDS 5.1.0.2. However, it is recommended to stop the RDA web server 
during the installation.

Shell requirements

The following settings are recommended for Solaris and Linux installation.

• On Solaris 10 - Korn shell (KSH) must be installed on the OS.

• Red Hat 5 - Korn shell is not available by default. Install the ksh on the OS 
or create a soft link from the zsh to ksh. 

Minimum disk space 
required

Minimum memory 
required

300 MB 512 MB 
IBM Rational Directory Server Installation Guide 15
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Root settings
Both Linux, and Solaris requires root user login to perform the installation and 
instance creation. You must have root access to start the RDS. 

Libraries and utilities

You must install the recommended libraries and utilities. For more information 
on the required libraries and utilities see, Operating system requirements (page 
13).

What is not supported
This section describes the modes or systems that are not supported by RDS. You 
must not use the modes or systems referred in this section to avoid any 
installation errors. 
This section contains the following components:

• Console mode installation

• NFS mounted system

Console mode installation

The RDS does not support non-graphical or console mode installation. Hence, 
the options such as -console is not supported by the RDS installer.

NFS mounted system

The RDS installation is not supported on NFS mounted systems. The /usr/
local/bin, /opt and the installation location should not be NFS mounted.
16 IBM Rational Directory Server Installation Guide
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Installing the RDS
Install the server as a root user. 
To Install RDS, do the following:

1. Unzip the RDS installer in a folder (use unzip or gunzip utilities).

2. Go to the install directory and set the execute permission to RDS.bin
chmod +x RDS.bin

Skip this step for CD and DVD installation.

3. The root user should have write permission to the below directories:
$ /usr/local/bin

$ /opt

The directories should not be NFS enabled.

4. Path settings:

• Ensure that the utilities: unzip, gunzip, dos2unix, userdel 
and groupdel are in the system path.

5. The DISPLAY environment variable should be appropriately set for the 
remote installation.
IBM Rational Directory Server Installation Guide 17
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6. In the install directory, type ./RDS.bin and press Enter. The 
Introduction dialog box is displayed.

7. Click Next. The License Agreement dialog box is displayed.

8. You can save the licence details in a document.

To copy the license information:

• Right-click the license window and click Select All, and then click Copy.
• Open any file, paste the license information and save the file.
18 IBM Rational Directory Server Installation Guide
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9. Review and click I accept the terms of the license agreement.
IBM Rational Directory Server Installation Guide 19



Chapter 3: Server Installation
10. Click Next. The Choose Install Folder dialog box is displayed. 

Click Choose to select an existing RDS 5.1 installation location. You can also 
edit the path manually by clicking anywhere in the text box. To use the 
default location, click the Restore Default Folder. This restores the default 
location provided by the installer.

Note  The IBM Tivoli Directory Server folder like/opt/IBM etc. 
are created outside the installation path.
20 IBM Rational Directory Server Installation Guide



Installing the RDS
11. Click Next. 
The Tivoli Home Folder dialog box is displayed.

12. Click Choose to specify the directory path where you have installed Tivoli. 
You can also type the path manually by clicking anywhere in the text box.
IBM Rational Directory Server Installation Guide 21
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13. Click Next. The Rational Directory Server Configuration dialog box is 
displayed. This defines the configuration settings for the RDS.

14. Type the directory server configuration properties. 

The field descriptions and the values to be entered in each field are explained in 
the following table.

Field name Description Values

Host Name The host name of the 
computer where the 
RDS 5.1 is installed.

Enter a valid computer 
name where the RDS 5.1 is 
installed.

Directory Server 
Port 

The port number of the 
RDS 5.1.

Enter the RDS 5.1 directory 
server port number.
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15. Click Next. Type the Directory Administrator User password.

The field description and the value to be entered in each field is explained in the 
following table.

Secure Port The LDAP Secure 
Socket Layer (SSL) 
port number. By 
default, the SSL is 
enabled by the installer 
using the secure port 
number provided 
during the installation.

Enter the RDS 5.1 secure 
port number in this field. 

Field name Description Values

RDS 
Administrator 
User ID

The user id for RDS 
administrator. 

The RDS administrator ID is 
set by default. The 
administrator ID cannot be 
modified.

Field name Description Values
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16. Click Next. The Pre-Installation Summary dialog box is displayed. This 
dialog box shows the installation summary. 

17. Review the information, and then click Install. The Install Complete dialog 
box is displayed if the installation is successful.

RDS 
Administrator 
User Password

The password for the 
RDS administrator 
user. 

Type the tdsadmin user
password that was set at the 
time of Tivoli installation.

Confirm 
Password

The password 
authentication for RDS 
administrator user.

Re-enter the password in the 
Confirm Password field. Both 
passwords should match for 
the installation to continue.

Field name Description Values
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18. Click Done to exit the installer.
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Post installation instructions
This section details the basic checks that you can perform to ensure that the 
installation has went through fine.
This section contains the following components:

• Starting the Web Server

• Review log files

Starting the Web Server

After installing RDS, start the Web server using the following command:

On Solaris: 
$> cd <RDS_Home>/WebAccessServer

$> ./Start_RDAWebAccessServer.sh

On Linux: 
$> cd <RDS_Home>/WebAccessServer

$> ./Start_RDAWebAccessServer.sh

After starting the server, login to RDS, click Help > About and confirm that 
the client and server version values have changed to 5.1.0.2.

Review log files

1. If the installation is corrupted and the server is not started, review the 
following log files carefully for any errors.
• <RDS_InstallHome>/RDS_5.1.0.2_InstallLog.log
• <RDS_InstallHome>/logs/ modify_5.1.0.2.log
• <RDS_InstallHome>/logs/schema-error_5.1.0.2.log

2. If the log files specify the installation has failed with Tivoli or DB2 errors, 
look for the server startup errors in ibmslapd.log.

Note  The above listed log files must be sent along with the other 
relevant information to the support specialist while reporting 
the errors. For more information on reporting the errors, see 
Contacting IBM Rational Software Support (page 2).
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Post installation instructions
Space issues
In case of space issues, delete the log files that are created under /tmp folder 
post installation to gain space. However, this is optional.
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4 Server Removal

Removing the RDS

This chapter describes the steps to remove RDS and Tivoli on all platforms. Remove
the server with the same user account that was used for installation. 
There is no separate uninstaller for RDS 5.1.0.2. Use the RDS 5.1 uninstaller to 
uninstall the RDS.
To remove RDS, do the following:

1. Go to the <RDS_Install_Dir>/UninstallRDS5.1 folder.

2. Type ./UninstallRDS5.1 and press Enter. The Uninstall RDS 5.1 
dialog box is displayed.

3. Click Uninstall to remove the RDS.

4. The Uninstaller removes the components one by one.

5. After removing all the components successfully, the Uninstall Complete 
dialog box is displayed. 

6. Click Done exit the installer.

Note  Follow the same procedure for uninstalling the RDS on Linux 
platform.
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5 Client Installation
Rational® Directory® Administration (RDA) is a GUI based client application 
helps the user to perform day-to-day administration tasks such as creating users, 
groups, roles, performing searches, migrating data, etc. 

Installing the RDA
This section describes the RDA installation on Solaris, and Linux platforms. To start
the installation, follow the instructions given below.
To install RDA, do the following:
You first need to set the execute permission for RDA.bin inorder to start the 
installation.

1. Unzip the RDA installer in a folder (use unzip or gunzip utilities).

1. Go to the install directory and set the execute permission to RDA.bin.
chmod +x RDA.bin

Skip this step for CD and DVD installation.
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2. In the install directory, type ./RDA.bin and press Enter to start the 
installation. The Introduction dialog box is displayed.

3. Click Next. The License Agreement dialog box is displayed. 

4. You can also save the licence details in a document. 

To copy the license information:

• Right-click the license window and click Select All, and then click Copy.
• Open any file, paste the license information and save the file.
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5. Review and click I accept the terms of the license agreement.
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6. Click Next. The Choose Install Folder dialog box is displayed. 

You can use the default location provided by the installer or click Choose to 
specify a different location. You can also edit the path manually by clicking 
anywhere in the text box. To use the default location, click the Restore 
Default Folder. This restores the default location provided by the installer.

.
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7. Click Next. The Pre-Installation Summary dialog box is displayed. This 
dialog box shows the installation summary. 

8. Review the information, and then click Install. The Install Complete 
dialog box is displayed if the installation is successful.
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9. Click Done to exit the installer.

Note  The Web Access Server is automatically started as a 
background process when the web access server is installed. 
After installation, verify the server is running using the 
following command: 
ps -ef | grep tomcat

If the tomcat process is not running, see the Troubleshooting 
RDS (page 41) section for details on starting the server.
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Removing the RDA

This chapter describes the steps required to remove RDA on all platforms. 
To remove RDA, do the following:

1. Go to the <RDA_Install_Dir>/UninstallRDA5.1 folder.

2. Type ./Uninstall_RDA_5.1.0.2 and press Enter. The Uninstall RDA 
5.1.0.2 dialog box is displayed.

3. Click Uninstall. The Uninstaller removes the components one by one. The 
Uninstall Complete dialog box is displayed if the uninstallation is successful.

4. Click Done to exit the installer.
IBM Rational Directory Server Installation Guide 37



Chapter 6:  Client Removal
38 IBM Rational Directory Server Installation Guide



7 Launching RDA
This chapter describes how to launch the RDA application. 
You can launch the desktop RDA that is installed on a client machine or the Web 
RDA from any machine by providing the appropriate URL. The Web RDA is 
supported on Mozilla browser.

Note  The RDA web server starts automatically during installation.

To start the RDA, do the following:

1. If the RDA web server is not started, run the following command to start the 
web server.

<RDA_Home>/WebAccessServer/Start_RDAWebServer.sh 

For example:
$> /var/IBM/Rational/RDA_5.1.0.2/WebAccessServer/
Start_RDAWebServer.sh

2. Open the browser and type the URL for the RDS:
http://<hostname>:8080/webrda/rda.

For example:
http://rdsserver:8080/webrda/rda

Note  The <hostname> refers to the name of the server where the 
RDS is installed.

3. The RDS Login dialog box is displayed.
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4. On the Login dialog box, type the details as:

5. Click Login.

Note  To stop the server, use the following command:
$> <RDS_Install_Dir>\WebAccessServer\apache-tomcat-
6.0.16\bin\catalina.sh shutdown

Field name Description

URL The LDAP URL should include a valid server name 
and a port number that was given at the time of RDS 
installation. 
For example: ldap://dirserv:1636.
To open the RDS in secure mode, you can include the 
letter "s" in the ldap URL (where the "s" refers to the 
secure port), followed by a valid server name and a 
port number. 

RDS Admin The admin user name for RDS. The admin user 
tdsadmin is set by the RDS installer.

Password The admin password set at the time of RDS 
installation. 
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8 Troubleshooting RDS
This chapter describes the possible problems and solutions for RDS users. 

Problem Solution

Installation was successful but server 
version is shown as 5.1.

Check the following logs:
<RDS_InstallHome>\logs\modify_5.1.0.2.log

<RDS_InstallHome>\logs\schema-error_5.1.0.2.log 
and make sure that all schema updates were successful. If there are 
any errors, it is possible that either the RDS 5.1 server was not 
running at the time of installation or an invalid tdsadmin 
credentials were given at the time installation.
Re-install the RDS 5.1.0.2 after starting the RDS 5.1 server and 
provide valid password for the tdsadmin user.
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Terms and Concepts

Term Definition

LDAP Lightweight Directory Access Protocol. directory 
service protocol designed to run over TCP/IP 
and across multiple platforms.

OS authentication Operating system authentication is the process of 
proving the identity of the client user to the 
directory server based on the operating system 
log on name.

PAM A pluggable authentication modules (PAM) is set 
of libraries and services used for authentication.

SSL A Secure Sockets Layer. (SSL) is a software library 
that establishes a secure connection between a 
client and server.

RDS Client A RDS client is a interface that requests services 
or information from a server. 
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Appendix: Notices
© Copyright 2000, 2010
U.S. Government Users Restricted Rights - Use, duplication, or disclosure 
restricted by GSA ADP Schedule Contract with IBM Corp.
This information was developed for products and services offered in the U.S.A. 
IBM may not offer the products, services, or features discussed in this document 
in other countries. Consult your local IBM representative for information on the 
products and services currently available in your area. Any reference to an IBM 
product, program, or service is not intended to state or imply that only that IBM 
product, program, or service may be used. Any functionally equivalent product, 
program, or service that does not infringe any IBM intellectual property right may 
be used instead. However, it is the user's responsibility to evaluate and verify the 
operation of any non-IBM product, program, or service. 
IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not grant you 
any license to these patents. You can send written license inquiries to: 

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A. 

For license inquiries regarding double-byte character set (DBCS) information, 
contact the IBM Intellectual Property Department in your country or send 
written inquiries to: 

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan 

The following paragraph does not apply to the United Kingdom or any other 
country where such provisions are inconsistent with local law: 
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES 
THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
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Some states do not allow disclaimer of express or implied warranties in certain 
transactions. Therefore, this statement may not apply to you. 
This information could include technical inaccuracies or typographical errors. 
Changes are periodically made to the information herein; these changes will be 
incorporated in new editions of the publication. IBM may make improvements 
and/or changes in the product(s) and/or the program(s) described in this 
publication at any time without notice. 
Any references in this information to non-IBM Web sites are provided for 
convenience only and do not in any manner serve as an endorsement of those 
Web sites. The materials at those Web sites are not part of the materials for this 
IBM product and use of those Web sites is at your own risk. 
IBM may use or distribute any of the information you supply in any way it 
believes appropriate without incurring any obligation to you. 
Licensees of this program who wish to have information about it for the purpose 
of enabling: (i) the exchange of information between independently created 
programs and other programs (including this one) and (ii) the mutual use of the 
information which has been exchanged, should contact: 

Intellectual Property Dept. for Rational Software
IBM Corporation
1 Rogers Street
Cambridge, Massachusetts 02142
U.S.A.

Such information may be available, subject to appropriate terms and conditions, 
including in some cases, payment of a fee. 
The licensed program described in this document and all licensed material 
available for it are provided by IBM under terms of the IBM Customer 
Agreement, IBM International Program License Agreement or any equivalent 
agreement between us. 
Any performance data contained herein was determined in a controlled 
environment. Therefore, the results obtained in other operating environments 
may vary significantly. Some measurements may have been made on 
development-level systems and there is no guarantee that these measurements 
will be the same on generally available systems. Furthermore, some 
measurements may have been estimated through extrapolation. Actual results 
may vary. Users of this document should verify the applicable data for their 
specific environment. 
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Information concerning non-IBM products was obtained from the suppliers of 
those products, their published announcements or other publicly available 
sources. IBM has not tested those products and cannot confirm the accuracy of 
performance, compatibility or any other claims related to non-IBM products. 
Questions on the capabilities of non-IBM products should be addressed to the 
suppliers of those products.
This information contains examples of data and reports used in daily business 
operations. To illustrate them as completely as possible, the examples include the 
names of individuals, companies, brands, and products. All of these names are 
fictitious and any similarity to the names and addresses used by an actual 
business enterprise is entirely coincidental. 
If you are viewing this information softcopy, the photographs and color 
illustrations may not appear. 
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Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of 
International Business Machines Corp., registered in many jurisdictions 
worldwide. Other product and service names might be trademarks of IBM or 
other companies. A current list of IBM trademarks is available on the Web at 
www.ibm.com/legal/copytrade.html.

Linux is a registered trademark of Linus Torvalds in the United States, other.
UNIX is a registered trademark of The Open Group in the United States and 
other countries. 
Java and all Java-based trademarks and logos are trademarks of Sun 
Microsystems, Inc. in the United States, other countries, or both. 
Other company, product or service names may be trademarks or service marks of 
others.
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